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dodać	recenzję?	Zaloguj	sie	Photoshop	now	comes	packaged	with	the	Adobe	Creative	Cloud	along	with	other	programs	like	InDesign	and	Adobe	Bridge.	While	the	interface	has	changed	over	the	years,	Photoshop	remains	one	of	the	most	powerful	image	editing	tools	available.	Information	in	this	article	applies	to	the	desktop	version	of	Adobe
Photoshop	CC	2019	for	Windows	and	Mac.	When	you	open	an	image	or	create	a	new	document	in	Photoshop,	you'll	be	taken	to	the	workspace.	The	interface	can	be	customized,	but	the	default	layout	consists	of	four	main	sections:	Main	taskbarTool	optionsToolboxPalettes	If	you	need	help	finding	a	specific	tool	or	panel,	select	the	magnifying	glass	in
the	top-right	corner	to	search	for	it.	You'll	also	have	the	option	to	download	free	graphical	assets	from	Adobe.	To	reset	your	Photoshop	preferences	back	to	the	default	settings,	hold	down	Ctrl	+	Alt	+	Shift	(on	Windows)	or	Command	+	Option	+	Shift	(on	Mac)	immediately	after	launching	Photoshop.	The	main	taskbar	consists	of	nine	menus:	File,	Edit,
Image,	Layer,	Type,	Select,	Filter,	3D,	View,	Window,	and	Help.	If	a	menu	command	is	followed	by	ellipses	(...),	selecting	it	will	open	a	dialog	box.	For	example,	when	you	select	File	>	Place	Embedded,	you'll	be	prompted	to	choose	another	image	that	you	want	to	embed	in	the	current	workspace.	The	tool	options	is	where	you	would	go	to	adjust
settings	for	the	currently	active	tool.	This	toolbar	is	context-sensitive,	which	means	that	it	changes	according	to	which	tool	you	have	selected.	For	example,	when	the	Text	tool	is	active,	you	can	adjust	the	size,	font,	and	alignment	of	the	text.	The	icons	on	the	left	side	of	the	workspace	represent	the	tools	you	have	to	work	with.	Select	the	arrows	at	the
top	of	the	toolbox	(below	the	Home	icon)	to	expand	the	toolbar	so	that	you	can	see	all	of	your	options.	Hold	down	the	mouse	button	as	you	click	each	icon	to	reveal	a	sub-menu	of	additional	tools.	Select	the	ellipses	(...)	at	the	bottom	of	the	toolbar	to	customize	your	preferences,	save	different	presets,	and	even	change	keyboard	shortcuts.	Some	tools
share	the	same	keyboard	shortcut.	For	example,	the	Rectangle	Marquee	and	Elliptical	Marquee	are	both	mapped	to	the	M	key.	To	switch	between	them,	press	Shift	+	M.	Select	the	colored	squares	near	the	bottom	of	the	toolbox	to	set	the	foreground	and	background	colors.	The	foreground	color	is	used	when	you	paint,	fill,	and	stroke	selections.The
background	color	is	used	when	you	make	gradient	fills,	to	fill	in	the	erased	areas	of	an	image,	and	when	you	expand	the	canvas.	Foreground	and	background	colors	are	also	used	by	some	special	effects	filters.	Click	and	hold	the	screen	mode	icon	in	the	bottom-right	of	the	toolbox	to	change	the	appearance	of	the	workspace.	Press	the	F	key	to	toggle
between	all	three	modes.	When	in	either	of	the	full	screen	modes,	you	can	toggle	the	menu	bar	on	and	off	with	the	shortcut	Shift	+	F.	You	can	also	toggle	the	toolbox,	status	bar,	and	palettes	on	and	off	with	the	Tab	key.	To	hide	only	palettes	and	leave	the	toolbox	visible,	use	Shift	+	Tab.	On	the	right	side	of	Photoshop,	you'll	see	the	palette	well	and
several	expanded	palette	panels.	Individual	palette	groups	can	be	moved	around	the	workspace	by	clicking	and	dragging	the	title	bar.	Select	the	menu	icon	in	the	title	bar	area	for	a	list	of	more	options.	Select	Close	Tab	Group	to	hide	the	palette.	If	you	don't	see	palette	you	need,	select	Windows	in	the	main	taskbar	and	choose	your	desired	palette.
You	can	also	ungroup	and	rearrange	the	palettes	by	clicking	on	a	tab	and	dragging	it	outside	of	the	group	or	to	another	group.	Some	palettes	can	be	resized	by	clicking	and	dragging	the	edges.	Several	palettes	can	be	joined	into	one	large	super-palette.	To	do	this,	click	and	drag	a	palette	over	the	title	bar	of	another	palette,	and	then	release	the	mouse
button.	When	multiple	palettes	are	grouped	together,	select	the	title	tab	for	the	palette	you	want	to	bring	to	the	front	of	the	group.	You	can	attach	several	palettes	this	way	to	create	one	massive	palette	collection.	This	can	be	useful	if	you	use	multiple	monitors	and	you	want	to	move	all	your	palettes	to	a	second	monitor.	By	docking	all	the	floating
palettes	together,	you	can	drag	then	all	to	the	second	monitor	with	one	click.	The	palette	well	is	the	vertical	column	of	icons	to	the	left	of	the	floating	palette	panels.	It's	a	place	to	keep	palettes	that	you	don't	want	occupying	your	workspace.	To	move	an	open	panel	to	the	palette	well,	simply	drag	and	drop	the	title	bar	into	the	column.	You	can	then
expand	the	palette	by	selecting	its	icon	from	the	well.	Select	the	arrows	in	the	top-right	corner	of	the	palette	panels	section	to	collapse	the	panels	into	a	side	bar	menu.	Select	Window	>	Workspace	>	New	Workspace	to	save	your	workspace	settings.	When	you	go	to	the	Window	>	Workspace	in	the	future,	you'll	see	your	new	saved	workspace	at	the
top	of	the	menu.	To	return	the	palettes	to	their	default	locations,	go	to	Window	>	Workspace	>	Reset.	If	you	open	another	document	while	in	the	Photoshop	workspace,	a	new	tab	will	open	under	the	tool	options	bar.	You	can	quickly	switch	between	documents	by	clicking	these	tabs.	Under	the	image	is	the	status	bar,	which	displays	various	information
about	the	current	document.	Select	the	arrow	in	the	status	bar	to	choose	which	information	to	display.	Adjust	the	zoom	by	selecting	View	from	the	menu	taskbar,	or	use	the	Zoom	tool.	If	you	want	the	document	window	to	resize	as	you	zoom	in	and	out,	select	Resize	Windows	to	Fit	box	in	the	tool	options	bar.	Select	Fit	to	Screen	to	make	the	entire
image	fit	within	the	workspace.	To	zoom	in	and	out	without	switching	to	the	zoom	tool,	hold	Ctrl	(on	Windows)	or	Command	(on	Mac)	and	press	the	plus	(+)	and	minus	(-)	keys.	Thanks	for	letting	us	know!	Tell	us	why!	Adobe	Photoshop	CC	2015	brings	big	performance	boosts	and	new	features	to	Creative	Cloud.	This	is	also	the	25th	anniversary
release	of	Photoshop.Adobe	Photoshop	CC	2015	Free	Download	marked	the	25th	anniversary	of	Photoshop.	Adobe	released	this	application	in	June	2015,	and	in	November	the	same	year,	the	company	updated	the	software	user	interface.	This	version	of	Creative	Cloud	differs	from	older	versions	of	Photoshop	in	that	it	offers	better	connectivity,
performance,	and	workflow.	Adobe	Photoshop	CC	2015	Download	Ensure	that	you	have	a	stable	internet	connection	to	download	Adobe	Photoshop	CC	2015	for	Windows.	Confirm	whether	your	computer	meets	the	minimum	requirements	to	run	Photoshop	CC	2015.	For	instance,	you	can	run	this	app	on	both	32-bit	and	64-bit	versions	of	Windows	7
SP1,	Windows	8,	and	Windows	10.	The	type	of	your	operating	system	the	size	of	free	hard	disk	space	you	need	to	install	CC	2015.	For	a	32-bit	operating	system,	you	need	2.6	GB,	while	64-bit	versions	require	3.1	GB.	This	image	editing	software	requires	an	AMD	Athlon	64	or	Intel	Core	2	processor	with	a	minimum	clock	speed	of	2	GHz.	You	will	also
need	a	display	unit	with	a	1024	x	768	resolution.	However,	Adobe	recommends	a	1280x800	resolution	display	unit	powered	by	a	16-bit	color	OpenGL	2.0	graphics	card.	Click	the	download	tab	and	Download	Adobe	Photoshop	CC	2015	using	our	safe	direct	download	link,	check	the	download	links	on	this	article	and	pick	the	option	that	corresponds	to
your	computer	operating	system.	Adobe	Photoshop	CC	2015	Features	Adobe	Photoshop	CC	2015	introduced	extra	features	not	found	in	earlier	versions	of	Photoshop.	For	instance,	the	Dehaze	tool	allowed	designers	to	remove	the	blur	effect	on	selected	areas.	The	Liquify	feature	in	this	app	comes	with	a	face-aware	capability.	This	way,	a	designer	can
retouch	portrait	images	with	ease.	When	editing	graphics	in	Photoshop,	a	designer	can	use	the	crop	tool	to	rotate	and	straighten	an	image.	The	Content-Aware	Crop	tool	in	Photoshop	CC	2015	fills	emerging	gaps	to	match	the	features	of	surrounding	objects.	This	tool	also	comes	in	handy	when	extending	the	canvas	beyond	the	size	of	your	photo.
Adobe	Photoshop	CC	2015	download	gives	you	easier	access	to	other	Adobe	products	than	earlier	Photoshop	versions	because	of	enhanced	integration.	For	instance,	it	is	possible	to	access	your	Photoshop	images	directly	from	Adobe	Stock.	The	program	has	a	filter	search	tool	that	allows	you	to	access	photos	on	Adobe	Stock.	Another	enhancement	to
Photoshop	that	came	with	CC	2015	is	the	glyph	panel	on	canvas.	With	this	application,	you	can	access	glyph	alternatives	on	canvas.	It	is	also	possible	to	print	3D	models	as	3	MF	files	using	Photoshop	CC	2015,	thanks	to	the	application's	compatibility	with	Product	Representation	Compact	data	in	PDF	documents	and	online	3D	printing	solutions.
Download	Adobe	Photoshop	CC	2015	and	experience	faster	image	editing	than	in	earlier	versions	of	Photoshop.	In	this	app,	the	Content-Aware	Fill	feature	and	Fonts	load	3X	and	4X	faster,	respectively.	Adobe	Photoshop	Versions	Adobe	Photoshop	2022	-	The	latest	release	as	of	Oct.	28th,	2021,	comes	with	AI	powered	object	selection,	new	neural
filters,	and	deeper	integration	with	Illustrator.	Adobe	Photoshop	2022	is	ideal	for	64-bit	Windows	10	and	Windows	11	users.	Adobe	Photoshop	2021	-	The	latest	release	as	of	Feb.	9th,	2021,	comes	with	invite	to	edit,	easy	sky	replacement,	neural	filters,	thousands	of	brushes	and	easy	one-click	selections,	and	so	much	more.	Adobe	Photoshop	2021	is
ideal	for	64-bit	Windows	10	users.	Windows	7,	Windows	8.1	not	supported	by	Adobe.	Adobe	Photoshop	2020	-	This	update	came	with	the	Object	Selection	feature,	drag	and	drop	shapes,	and	linked	smart	objects.	Adobe	Photoshop	2020	free	download	is	ideal	for	Windows	7	or	newer.	Adobe	Photoshop	CC	2019	-	Focused	on	fixing	bugs	and	revamped
multiple	undos,	preview	blend	modes,	and	content-aware	fill	taskspace.	Adobe	Photoshop	CC	2019	free	download	is	ideal	for	Windows	7	or	newer.	Adobe	Photoshop	CC	2018	-	Adds	upscale	photos	with	AI,	variable	fonts,	and	access	to	Lightroom	photos.	Adobe	Photoshop	CC	2018	free	download	is	ideal	for	Windows	7	or	newer.	Adobe	Photoshop	CC
2017	-	This	update	enhanced	the	integration	between	Photoshop	and	other	Adobe	products	such	as	Adobe	XD,	Typekit	marketplace,	and	better	performance.	Adobe	Photoshop	CC	2017	is	ideal	for	Windows	7	or	newer.	Adobe	Photoshop	CC	2015	-	Resolved	earlier	issues	and	bugs	while	adding	adobe	stock	marketplace,	design	space,	and	hundreds	of
other	updates	through	2015	and	2016.	Adobe	Photoshop	CC	2015	is	ideal	for	Windows	7	or	newer.	Adobe	Photoshop	CC	2014	-	First	release	of	Photoshop	Creative	Cloud	(CC)	series.	The	most	notable	are	camera	shake	reduction,	intelligent	upsampling,	and	sync	with	the	cloud.	Adobe	Photoshop	CC	2014	is	ideal	for	Windows	7	or	newer.	Adobe
Photoshop	CS6	-	Last	perpetual	license.	This	version	highlights	UI	redesign,	auto	and	background	saves,	and	new	property	adjustments.	Adobe	Photoshop	CS6	free	download	is	ideal	for	Windows	XP	SP3	or	newer.	Adobe	Photoshop	CS5	-	Adds	content-aware	fill,	automatic	lens	correction,	easy	HDR,	and	improved	selection	and	masking	controls.	Adobe
Photoshop	CS5	free	download	is	ideal	for	Windows	XP	SP3	or	newer.	Adobe	Photoshop	CS4	-	Presents	OpenGL	acceleration	for	smoother	panning	and	zooming.	Photoshop	CS4	free	download	is	ideal	for	Windows	XP	SP2	or	later,	plus	64-bit	support	for	Windows	Vista	x64.	Adobe	Photoshop	CS3	-	Introduces	a	revised	user	interface,	quick	select	tool,
and	auto-align.	Adobe	Photoshop	CS3	free	download	is	ideal	for	Windows	XP	SP2	or	later.	Should	I	upgrade	to	the	latest	version	of	Photoshop?	Absolutely!	You	can	jump	into	Adobe's	photography	plan	for	only	$9.99	per	month,	including	Lightroom	on	desktop	and	mobile,	which	is	fantastic	for	processing	raw	images.	Plus	Adobe	Portfolio,	Adobe	Fonts,
and	Adobe	Spark.	Adobe	Photoshop	is	an	incredible	deal	on	its	own,	and	if	you're	still	unsure,	you	can	always	give	the	free	trial	a	go	first.	All	your	photography	essentials.	Includes:	Lightroom	on	desktop	and	mobile	Lightroom	Classic	Photoshop	on	desktop	and	iPad	Step-by-step	tutorials	Adobe	Portfolio,	Adobe	Fonts,	and	Adobe	Spark	20GB	storage
Get	the	Adobe	Creative	Cloud	Photography	plan	starting	at	just	$9.99/mo.	Students	&	Teachers	save	over	60%	and	get	the	entire	collection	of	20+	creative	desktop	and	mobile	apps	for	only	$19.99/mo	for	the	first	year	and	$29.99/mo	after	that.	Save	Adobe	Photoshop	CC	2015	This	version	of	Adobe	Photoshop	CC	2015	is	free	to	download	and	install
and	suitable	for	both	your	professional	and	learning	needs.	As	the	first	major	update	and	release	of	Creative	Cloud	you'll	immediately	notice	improved	performance	compared	the	to	creative	suite	versions	and	numerous	new	features	that	make	graphics	design	easy	and	fun.	Note:	This	version	of	Adobe	Photoshop	is	7	years	old.	If	you're	looking	for	the
latest	and	greatest	features	like	AI	object	selection	and	more,	upgrade	to	the	lastest	version	of	Adobe	Photoshop	for	best	in	class	graphics	design	and	editing.	Summary:You	can	run	Adobe	Photoshop	CC	2015	on	Windows	XP,	Windows	Vista,	Windows	7	operating	systems.	Adobe	Photoshop	CC	2015	is	a	software	product	developed	by	Adobe	and	it	is
listed	in	Graphic	&	Design	category	under	Editors.	Adobe	Photoshop	CC	2015	is	licensed	as	Trial	which	means	that	software	product	is	provided	as	a	free	download	to	users	but	it	may	be	limited	in	functionality	or	be	time-limited.	You	may	need	to	pay	at	some	moment	to	continue	using	product	or	to	use	all	functionalities.	Adobe	Photoshop	CC	2015
was	last	time	updated	on	Apr	9th,	2021	to	version	CC	2015.Download	Adobe	Photoshop	CC	2015Download	and	install	Adobe	Photoshop	CC	2015	safely	and	without	concerns.	Minimum	Requirements	AMD	Athlon	64	or	Intel	Core	2	processor	2	Ghz	Windows	7	SP1,	Windows	8.x,	and	Windows	10	2.6	GB	disk	space	for	32-bit,	3.1	GB	for	64-bit	Display	of
at	least	1024x768	with	1280x800	recommended	16-bit	color	with	OpenGL	2.0	graphics	card	Adobe	Photoshop	CC	2015	awards
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